ChiroSuite EHR MU Manual
This manual was produced using ComponentOne Doc-To-Help.™
## Contents

Documenting Medicare's Meaningful Use in ChiroSuite EHR And ChiroPad EMR ......................................................... 1

Clinical Quality Measures Calculation Parameters ........................................................................................................... 3

Automated Measurement Calculation Parameters ........................................................................................................... 11

Chapter 1 – Basic Settings ...................................................................................................................................................... 15

Chapter 2 - Access Control and Authentication ............................................................................................................... 21

Chapter 3 - Demographics ....................................................................................................................................................... 25

Chapter 4 – Examination Findings ........................................................................................................................................ 27

Chapter 5 – Smoking Status ..................................................................................................................................................... 31

Chapter 6 – Medications and Medication Allergies ................................................................................................................ 33

  For Those That NEVER Write Prescriptions .......................................................................................................................... 34
  For Those That Write Prescriptions and Use Electronic Prescribing ..................................................................................... 36

Chapter 7 – Medicare’s Problem List ...................................................................................................................................... 39

Chapter 8 – Computerized Provider Order Entry ................................................................................................................ 43

Chapter 9 – Clinical Decision Support .................................................................................................................................. 45

Chapter 10 – Patient Education Resources .......................................................................................................................... 47

Chapter 11 – EHR Reports ....................................................................................................................................................... 49

  Patient Reminder List .............................................................................................................................................................. 49
  Patient Lists ................................................................................................................................................................................. 52
  EHR Audit Log ............................................................................................................................................................................. 53
  EHR Automated Measure Calculation .................................................................................................................................. 53
  EHR Clinical Quality Measures .............................................................................................................................................. 55

Chapter 12 – Timely Access ...................................................................................................................................................... 57

  Creating an Updox account ...................................................................................................................................................... 57
  Installing the ChiroPad Connector for Updox .......................................................................................................................... 61
  Configuring the ChiroPad Connector for Updox ...................................................................................................................... 63
  Logging in to Updox ................................................................................................................................................................... 65
Verifying the ChiroPad Connector is Working.......................................................... 66
Setting up the Patient's Updox Patient Portal Account ........................................ 66
Creating a CCR file to send to the Updox Patient Portal ...................................... 68

Chapter 13 – Clinical Summaries and Electronic Copy .......................... 71

Chapter 14 – Exchange Patient Summary Record ..................................... 73

Chapter 15 - Encryption and Integrity ......................................................... 75

Chapter 16 – Immunizations ................................................................. 77

Chapter 17 – PQRS Codes ........................................................................ 79
  Complying with the Mandatory and Required codes ........................................ 80
  PQRS for 2013 is NOT the Same as 2012 ...................................................... 80
  Pain Assessment uses the following G-codes: ............................................... 83
  Functional Outcome Assessment uses the following G-codes: ..................... 83
  Using the PQRS codes .............................................................................. 86
  Activating the PQRS codes in ChiroPadEMR ........................................... 88
  Link the Codes from ChiroPadEMR to ChiroOffice .................................... 90
  Activating the PQRS codes in ChiroOffice ................................................ 92

Chapter 18 - How to Get the Meaningful Use Numbers Right .................. 95
  Adult Blood Pressure/Hypertension Screening ............................................ 95
  Adult Weight Screening and Follow-Up AND Weight Assessment and Counseling for Children ............................................................ 98
  Asthma Assessment .................................................................................... 100
  Tobacco and Tobacco Use Cessation Intervention ...................................... 101
  Childhood Immunization Status ................................................................. 103
  Flu Immunizations for Patients 50 and older ........................................... 103
  Low Back Pain: Use of Imaging Studies .................................................... 104
  Diabetes: Foot Exam .................................................................................. 106
  Anti-Depressant Medication Management ................................................ 108
  Automated Measure Calculations ................................................................ 110

Index ........................................................................................................... 123
Documenting Medicare’s Meaningful Use in ChiroSuite EHR And ChiroPad EMR

Introduction
In order to encourage all doctors to enter the digital age, eliminate paper files, and enhance communication between doctors and health care facilities, the US Congress enacted legislation which was signed by the President requiring the use of Electronic Health Records (EHR) by the end of 2014. To persuade doctors to use EHR sooner rather than later, the legislation included bonus incentive payments that would be given to each doctor, provided that the doctor could demonstrate Meaningful Use of the EHR computer software. The new law also required the certification of the EHR programs, meaning that the certified EHR would be able to fulfill all the requirements of Meaningful Use.

A large part of Meaningful Use is a bureaucratic requirement that will allow the easy gathering of statistics by and for the government. During this year (2012) it is expected that you will only need to attest (legally affirm) that you have performed the Meaningful Use items. Starting in either 2013 or 2014 it will be necessary to transmit the Meaningful Use data to Medicare or another agency to be designated by Medicare or the government.
<table>
<thead>
<tr>
<th>NQF001</th>
<th>Asthma Assessment</th>
<th>Patient age 5 to 40 inclusive Patients with Diag codes $\geq 489$ And $&lt;494$ Symptoms of asthma daytime or nighttime</th>
<th>Age as recorded in Patient, Patient Information. Fig 1 Daily SOAP, Assessment/Dx, Diagnosis Sets. Fig 2 Daily SOAP, Subjective, Anterior or Posterior Chest area - Fig 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>NQF0013</td>
<td>Adult Blood Pressure/ Hypertension</td>
<td>Diag code 401* (Essential Hypertension) Blood pressure recorded</td>
<td>See Fig 2. Daily SOAP, Objective, Physical Button – Fig 4</td>
</tr>
<tr>
<td>NQF0024</td>
<td>Weight Assessment and Counseling for Children and Adolescents</td>
<td>Populations: $2 \leq \text{age} \leq 16$ $2 \leq \text{age} \leq 10$ $11 \leq \text{age} \leq 16$ Had a physical exam w/ height and weight recorded Received counseling for nutrition Received counseling for physical activity</td>
<td>Age as recorded in Patient, Patient Information. Fig 1 Daily SOAP, Objective, Physical Button – Fig 4 Daily SOAP, Plan, Scroll to appropriate modality – Fig 5</td>
</tr>
<tr>
<td>NQF0027</td>
<td>Tobacco and Tobacco Use Cessation Intervention</td>
<td>Patients $&gt;17$ w/ physical in last 12 months Tobacco user Tobacco intervention modality CouTobPQRI CouTobStop CTob10PQRI CTobStop10 SmokDeter NicoPatch ZeroNico TobCessGm</td>
<td>Age as recorded in Patient, Patient Information. Fig 1 Date of last physical exam Tobacco use: History, Health, Prior Illness Tab, Smoking Status – Fig 6 Daily SOAP, Plan, Scroll to appropriate modality – Fig 5 Counseling Tobacco Cessation Tobacco Cession</td>
</tr>
</tbody>
</table>
Clinical Quality Measures Calculation Parameters
<table>
<thead>
<tr>
<th>NQF0038</th>
<th>Childhood Immunization Status</th>
<th>Children between 1 and 2 Having received the following vaccinations: DTaP IPV MMR (or its components) HiB HepB VZV Pneumo HepA Rotavirus Influenza</th>
<th>Age as recorded in Patient, Patient Information. Fig 1 History, Immunization – Fig 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>NQF0041</td>
<td>Flu immunizations for Patients &gt;= 50</td>
<td>Patients &gt;= 50 not allergic to flu vaccine CVX Code</td>
<td>Short Description</td>
</tr>
<tr>
<td></td>
<td></td>
<td>16 influenza, whole</td>
<td>88 influenza, unspecified formulation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>135 influenza, high dose seasonal</td>
<td>140 influenza, seasonal, injectable, preservative free</td>
</tr>
<tr>
<td></td>
<td></td>
<td>141 influenza, seasonal, injectable</td>
<td>144 influenza, seasonal, intradermal, preservative free</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Age as recorded in Patient, Patient Information. Fig 1 History, Immunization – Fig 7</td>
<td></td>
</tr>
<tr>
<td>NQF0052</td>
<td>Low Back Pain: Use of Imaging Studies</td>
<td>Patients 18 to 49 inclusive With any of diag codes: 724.9, 724.2, 353.4, 355, 648.7, 721.3, 721.42, 722.52, 739.3, 846, 847.2, 953.2 Image of Lumbar or Pelvic region within 28 days of diagnosis</td>
<td>Age as recorded in Patient, Patient Information. Fig 1 Daily SOAP, Assessment/Dx, Diagnosis Sets. Fig 2 Daily SOAP, Objective, DIR button – Enter Pelvic or Lumbar imaging – Fig 8</td>
</tr>
</tbody>
</table>
| NQF0056 | Diabetes: Foot Exam | Patients diagnosed with DM or taking diabetic related medications.  
- Actoplus MET (pioglitazone-metformin)  
- Onglyza (saxagliptin)  
- Novolin 70/30 (insulin nph & regular human)  
- Diabeta (glyburide)  
- Actoplus Met Diabetics with diabetic foot exam | Patients with either a history of diabetes or taking a diabetes medication  
Prescriptions, Medications – Fig 9  
Daily SOAP, Plan, Modality, **Diabetic Foot Exam** – Fig 5 |
| NQF0105 | Anti-Depressant Medication Management | Patients 18 and over  
Diag codes >=296.3 And <=296.36  
Taking an anti-depressant drug:  
- Paxil (paroxetine)  
- Prozac (fluoxetine)  
- Effexor (venlafaxine)  
- Buspar (buspirone)  
- Pertofrane (desipramine)  
- Lauox (fluvoxamine)  
- Sinequan (doxepin)  
- Tofranil (imipramine)  
- Pamelor (nortryptiline)  
- Elavil (amitriptyline)  
- Desyrel (trazodone)  
- Wellbutrin (bupropion)  
- Ludiomil (maprotiline)  
- Cymbalta (duloxetine)  
- Norpramin (desipramine)  
- Endep (amitriptyline)  
- Celexa (citalopram)  
- Anafranil (clomipramine)  
- Adapin (dextrophen)  
- Zoloft (sertraline)  
- Pristiq (desvenlafaxine)  
- Lexapro (escitalopram oxalate)  
- Edronax, Vestra (reboxetine)  
- Vivactil (protriptyline)  
- Nardil (phenelzine)  
- Serzone ( nefazodone)  
- Parmitil (tranylcypromine)  
- Surmontil (trimipramine)  
- Remeron (mirtazapine) | Daily SOAP, Assessment/Diagnosis, Depression diag codes. Fig 2  
Prescriptions, Medications – Fig 9 |
| NQF0421 | Adult Weight Screening and Follow-Up | Seniors ages 65+  
Adults ages 18 to <65  
With physical w/in last 6 months and height and weight checked.  
Exclusions for pregnancy and terminal illnesses | Age as recorded in Patient, Patient Information. Fig 1  
Daily SOAP, Plan, Modalities |
On plan if underweight or overweight.
BMI
Nutri15ini
NutriReAss
CFN

**Clinical Quality Measures Calculation Parameters**

| Figure 1 – DOB |
| Figure 2 |
Figure 3

Figure 4
Figure 9
## Automated Measurement Calculation Parameters

<table>
<thead>
<tr>
<th>Parameter Description</th>
<th>Numerator</th>
<th>Denominator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patients with diagnoses</td>
<td>Patients diagnosed this year</td>
<td>Patients visits this year</td>
</tr>
<tr>
<td>Patients on Medication</td>
<td>Number of patients on medns</td>
<td>Patients visits this year</td>
</tr>
<tr>
<td>Patients with allergies assessed</td>
<td>Number of patients with allergies to medication</td>
<td>Patients visits this year</td>
</tr>
<tr>
<td>Patients with demographics collected</td>
<td>Number of patients with all of the following data collected:</td>
<td>Patients visits this year</td>
</tr>
<tr>
<td></td>
<td>Sex, DOB, Preferred Language, Ethnicity, Race</td>
<td></td>
</tr>
<tr>
<td>Patient Education</td>
<td>Patients receiving educational information this year</td>
<td>Patients visits this year</td>
</tr>
<tr>
<td>CPOE</td>
<td>Patients with medications ordered</td>
<td>Patients on medication</td>
</tr>
<tr>
<td>Patients with BMI, BP assessed</td>
<td>Patients over 2 where height, weight and BP were measured this years</td>
<td>Patients visits this year</td>
</tr>
<tr>
<td>Patients who smoke</td>
<td>Patients over 13 who smoke</td>
<td>Patients visits this year</td>
</tr>
<tr>
<td>Incorporate Lab test results</td>
<td>Clinical Lab test results received by the HER system this year</td>
<td>All clinical lab tests ordered during the year.</td>
</tr>
<tr>
<td></td>
<td><em>Note: Always 100% as lab tests cannot be ordered via CP</em></td>
<td></td>
</tr>
<tr>
<td>Electronic copy of patient health info</td>
<td>Number of patients who requested a copy of their health records and received</td>
<td>Total number of patients who requested a copy of their health records.</td>
</tr>
<tr>
<td></td>
<td><em>Note: Always 100% as HER records are presented to the patient on request.</em></td>
<td></td>
</tr>
<tr>
<td>Medication reconciliation</td>
<td>Incremented when Medical Reconciliation Performed checkbox is checked</td>
<td>Incremented when Patient Was Referred to Provider is checked</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Fig 10</td>
</tr>
<tr>
<td>Patient Summary Record</td>
<td>Incremented when Patient Summary: Discharge Info Provided checkbox is checked</td>
<td>Incremented when Patient was referred out checkbox is checked</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Fig 10</td>
</tr>
<tr>
<td>Timely Access</td>
<td>Incremented when Patient File Sent to Portal w/in 4 days checkbox is checked</td>
<td>Number of visits during current year.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Fig 10</td>
</tr>
<tr>
<td>Generate and transmit eRx</td>
<td>Incremented when Electronic Rx button is clicked</td>
<td>Incremented when Print Rx button is clicked</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Fig 10</td>
</tr>
<tr>
<td>Clinical Summaries</td>
<td>Incremented when Produced Clinical Summary w/in 3 days checkbox is checked</td>
<td>Number of visits during current year.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Fig 10</td>
</tr>
</tbody>
</table>
Patient reminders

Numerator=Incremented for each patient whose age is <5 or >65 when those patients appear on the Patient Reminder report.

Denominator= Number of visits during current year for patients over 65 and under 5

See fig 11 thru 13
### Automated Measurement Calculation Parameters

#### Figure 13

<table>
<thead>
<tr>
<th>Patient ID</th>
<th>First Name</th>
<th>Last Name</th>
<th>Age</th>
<th>Sex</th>
<th>Referral Source</th>
<th>Referral Code</th>
<th>Referral Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>2008-00001</td>
<td>Christopher</td>
<td>Jones</td>
<td>55</td>
<td>M</td>
<td>USA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2011-00123</td>
<td>John</td>
<td>Doe</td>
<td>60</td>
<td>F</td>
<td>Canada</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Note: This table is an example of how automated measurement calculation parameters can be recorded and referred to.*
Chapter 1 – Basic Settings

For Meaningful Use to function correctly, the ChiroPadEMR section of ChiroSuiteEHR must have specific items functioning. This involves basic settings to turn on/off those specific items.

After the program is open click on Tools and select Settings.
When the Settings window opens, click on the SOAP notes icon

Once the SOAP Notes settings window is open, verify the settings that will meet Medicare’s requirements, whether or not they are for Meaningful Use. Specifically, the Reporting Sequence should be from Severe to Normal, there should be a check in the box to Report L/R/B (Left/Right/Bilateral), and the Muscle Names should be set to Detail.

The setting for Default Initials should contain the **doctor’s full name and credentials** as shown in this example. This is specific to each computer. If there are multiple doctors in the practice, each can set his/her own name as the default on
his/her own computer. Be sure there is a check in the box to Use Extended Format enabling the note to be signed according to Medicare’s standard. If the doctor’s name does not appear in the Default Initials box, it will need to be entered in the Notes Customization window.

To customize the Default Initials with your personal items, click on Tools►Customize.
The Customizations screen will open.
Click the + symbol next to the word Notes to expand only that part of the tree. Then click on Initials.

Clicking on Initials will bring up the Doctor/Transcriptionist screen where you are able to add or delete the initials or name of the doctor or staff member. Whenever a progress note is composed, you will be able to include in the note the initials/name of the person that composed it.

To add initials or names, click on the yellow Add button.
After clicking on the Add button, a little box will pop up entitled Add New Initials, where you enter a provider or staff member’s name. Once you have typed the name and credentials, click OK and the name will appear in the Doctor/Transcriptionist Initials screen. Click Close when you are done with this screen.

Now return to the Settings window and select the doctor’s name that should be entered at the end of each SOAP note on that computer.

While still in the Settings window, click on the Preferences button.
This opens the General Settings area. Towards the bottom of this window there are 2 items related to Meaningful Use, the Auto Lock/Auto Log Off and the Disable EHR MU Prompts. To turn either on, place a check in the box, or to shut off leave them unchecked.

To comply with Meaningful Use, AutoLock/Auto Log Off should have a check in the box. Once it is checked on, you can set the number of minutes of inactivity on the computer which will then blank the screen.

Auto Lock hides the screen, but allows you to resume where you left off as soon as you enter your password.

Auto Log Off closes the program completely.

Disable EHR MU Prompts should NOT be checked to make sure you fulfill all the Meaningful Use requirements.
Chapter 2 - Access Control and Authentication

Meaningful Use requires that you clearly control who has access to your HIPAA protected patient information. Each and every person that works in your practice is required to have his/her own log in. It is then up to you to set the permissions for each employee, consultant, partner and/or doctor. This is done through User Security. Go to Tools, Select Catalogs, and then click on User Security.

The User Security window will open displaying all the doctors, providers, consultants and employees that have been entered into the system.

To add someone to the system, click the Add button.

If you need to revise the security settings for any individual on the list, click on the person’s name and then the Edit button.
The User Security Add and Edit section opens to the basic information for the individual. This is where each user is authenticated.

- Create a 3 to 5 digit ID for a new addition to the system. Note that this is the one item on this window that once created and saved can NOT be changed.
- Enter the person’s name
- Create a unique password that is unique and specific to this individual
- If this person is a provider, select his/her provider ID
- Create the emergency access password for a lower level employee that may need to access the system in an emergency when the higher level person is not available
As individuals are hired, join the practice and are added to the system, the Status defaults to Active. In the event that the person leaves the practice, for security purposes, the Status should be changed to Inactive. Once it is made Inactive, that person would no longer be able to log in to the program.

Click on the Permissions tab to set the functions in the system that this user will have access to. A simple check in a box allows this user to perform that function, or a check missing from a box means that the user can not access that feature. This controls which functions in the program this user will be able to access and use. Go through the list carefully and decide which functions to turn on/off for each user. For the purposes of Meaningful Use, scroll down to the bottom of the list. For each provider and staff member that needs to use the Meaningful Use reports, be sure there is a check in the box to View EHR Audit Log. For any user that should have emergency access to the full system, place a check in the Manage Emergency Access box.

![User Permissions](image)

Emergency Access gives full unrestricted access to patient information. It requires that the permission be set as shown in Figure 12. In the user window, a unique emergency access password can be set for each employee (see Figure 11). After logging in using the user’s emergency password, the system will give a pop up that requires the special Emergency Access password to give full permissions to the system. At this time, the default is the word emergency.
Chapter 3 - Demographics

The demographics window is accessed when the patient file is open. Click on the Patient Info icon in the far left column and the demographics window opens.

**For Meaningful Use purposes, Medicare requires 5 specific demographic information items.** This data is entered on the Patient Information window when the patient’s account is open.

Click on the drop down arrow and select each item.

Note that the selections for Race and Ethnicity are dictated by the government and are not modifiable. Although only 5 items are currently required for Meaningful Use, all the other demographic items are required by state law, insurance programs, or practical necessity.
Chapter 4 – Examination Findings

Meaningful Use monitors a few physical findings, primarily focused on height, weight and blood pressure.

To access the Physical Exam areas, with the patient account open, click on either the Objective icon or the Exams button.
From the Objective window, click on the button for Physical

Or from the Exams button, select Physical

For purposes of Meaningful Use, height, weight and blood pressure must be measured and recorded at least once every 6 months.
Height and weight must be monitored for all patients beginning at age 2 (two).

For patients between the ages of 2 and 20, entering height and weight automatically produces the Growth Chart.

Blood pressure can be entered as only a single entry (right or left) or both. This entry fulfills the hypertension screening required for Meaningful Use.

The BMI (body mass index) is automatically calculated upon entering the height and weight, and shows the patient’s weight status.
Chapter 5 – Smoking Status

For Meaningful Use, Medicare requires that the smoking habits of every patient age 13 and above are recorded. To be sure of compliance, this should be verified and noted at least once every 6 months.

With the patient account open, click on the History button.

Once the History section is open, click on the Health icon.
The Smoking Status for Meaningful Use is entered on the Prior Illnesses tab of the Health History window.

On the lower left side of the window, find the **Smoking Status** drop down and select the appropriate item. This is a government dictated list. For Meaningful Use purposes, do NOT use the Smoking item that displays just above Smoking Status.

Note that for Meaningful Use this data must be entered for every patient beginning at age 13. The entry should be updated at least once every 6 months.
Chapter 6 – Medications and Medication Allergies

The ChiroPadEMR section of ChiroSuiteEHR has 2 options for Medications and Medication Allergies, one for those that never write prescriptions and a second for those that incorporate other practitioners that do write prescriptions.

General Information
Medicare has been ambiguous about Chiropractors, medications, and medication allergies when it comes to Meaningful Use.

- One part of the Medicare website indicates that Chiropractors have an exclusion from reporting since Chiropractors do not prescribe medications. Another part of the Medicare website states that there are no exclusions for the medication and medication allergies lists.
- Medicare also has different definitions of medications. In some places a medication is defined strictly as a prescription item; in others the definition includes prescription drugs, over the counter medications, food supplements, nutriceuticals, herbal remedies, homeopathic substances, and naturopathic items.

The Life Systems Software recommendation to you is to protect yourself, get the information from your patient, and enter it on the Medications window. It is better to have it and not need it, than to need and not have it.
For Those That NEVER Write Prescriptions

To enter the Medication information, with a patient account open, click on the Prescriptions button at the bottom of the icon column.

![Medications icon]

The Medications icon is now displayed. Click it to open the Medications window.

**Note:** Since Chiropractors do NOT write prescriptions, they are excluded from reporting drug formulary, drug-drug, and drug-allergy checks, as well as the exchanging of e-prescription information. If there is a provider in the practice that does write prescriptions (MD, DO, DMD, DDS, DPM, NP or PA), a subscription to DrFirst will be necessary for these functions to be present.

The Medications window enables the recording of all the information required by Meaningful Use. A simple list is NOT acceptable. To get all the data, it may be necessary to have the patient bring in the bottle and copy the information from the label.

On the Active tab, select the specific medication in the central column, so that it is highlighted. This will enter its name in the column on the right.
After entering the data, click on the red check to Update the patient file. This moves the Active item to the box on the far left. All Active items will be shown. Making any medication Inactive, removes the item from this box. Note that both Active and Inactive items will be listed on the Medications List.

If a patient reports taking a medication that is not on the list, click the New icon (Add button) to include it. If Medicare requires inclusion of nutrition substances, add them here. When the computer is connected to the internet, clicking the Medication Information button opens the Medline Plus Connect service of the National Institutes of Health. The information about the medication can be printed for the patient.

When it is necessary to view and print a complete list of all the patient’s medications, click the Medications List button on the lower right of this window.
Medication Allergies are noted by clicking on the Allergies tab. Select the medication that triggered an allergic response by clicking on it once, so it is highlighted.

For Those That Write Prescriptions and Use Electronic Prescribing

Electronic prescribing requires a different method of documenting and monitoring prescriptions given. For those that use and prescribe drugs and medications in your practice, there are a couple of things you need to do:
• Subscribe to DrFirst RCopia to have the electronic prescribing ability. Details about DrFirst RCopia will be provided directly to those offices that require it.
• Turn on eRx Access in the permissions tab of User Security by placing a check in the box.
Chapter 7 – Medicare’s Problem List

Instead of using the term ‘diagnosis’, the bureaucrats used the word ‘problem’. Simply put, the Problem List is the patient’s Diagnosis List. It includes every diagnosis that you have given to the patient over the course of time. It shows the date the diagnosis was given, both the ICD and verbal descriptions and whether the diagnosis is Active, Inactive, or Resolved. Medicare has not yet clearly defined the difference between Inactive and Resolved. In the ChiroPadEMR section of ChiroSuiteEHR, the Problem List is built automatically every time you enter a new diagnosis for the patient.

When the patient file is open, click the Assessment/Dx icon. This opens to the Assessment tab. To enter or view the patient’s diagnoses, click the Diagnosis Sets tab.
### Medicare's Problem List

<table>
<thead>
<tr>
<th>No.</th>
<th>ID</th>
<th>ICD</th>
<th>Modifier</th>
<th>Brief Description</th>
<th>DueDate</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>723.31</td>
<td>723.3</td>
<td></td>
<td>Subluxation Multiple Lumbar Vertebrae</td>
<td>2/5/2012</td>
<td>Active</td>
</tr>
<tr>
<td>2</td>
<td>956.0</td>
<td>956.0</td>
<td></td>
<td>Spinal Stenosis, Lumbarocaudal</td>
<td>2/5/2012</td>
<td>Active</td>
</tr>
<tr>
<td>3</td>
<td>956.5</td>
<td>956.5</td>
<td></td>
<td>Injury, LumboSacral nerve root</td>
<td>2/5/2012</td>
<td>Active</td>
</tr>
<tr>
<td>4</td>
<td>722.10</td>
<td>722.10</td>
<td></td>
<td>Displacement of Lumbar IV/D, w/onyeapex</td>
<td>2/5/2012</td>
<td>Active</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Narrative Diagnosis

- **ADL Walking**
- **Cervical**
- **Headache**
- **Lumbar**
- **MUA**
- **Pregnancy**
- **Thoracic**

### Customize DX Patterns

![Diagnosis Pattern](image)
Click the New icon to create a new diagnosis. Before clicking New, make sure that the Use DX Date Chooser is checked. Upon clicking New, the Dx Date Chooser will pop up so you can verify the date this diagnosis should begin on. Once you select the date, this feature verifies that the new diagnosis applies to the correct date of service and is displayed in the Established Sets box.

Click on the Diagnosis Pattern that contains the ICD codes that is most appropriate to the patient. The selected Pattern will appear in the lower right box. Click on each diagnosis in the sequence that you want it to appear in your SOAP notes and on the CMS1500 claim form. Click the Apply button to move the diagnosis sequence to the top box.

Remember to click the Save icon when you have completed your entry.

The DX Information button opens to the Medline Plus Connect service of the National Institutes of Health. Click on a specific diagnosis in the upper box, then click the DX Information button to display information about the diagnosis that can be printed for the patient.

As each new diagnosis is created, the system defaults to a Status of Active. It is critically important that the status is changed when the diagnosis is either resolved or inactive.

Producing Medicare’s up to date Problem List is simple. Just click the Diagnosis List button.
Chapter 8 – Computerized Provider Order Entry

Computerized Provider Order Entry (CPOE) is used to record any order for special services that you give to or for the patient. This includes orders for Lab Tests, Physical Therapy, Radiology, Referrals, etc. Even if you are performing any of these services in your own office, it is imperative that you enter each item in the CPOE section.

To fulfill this Meaningful Use requirement, the patient account must be open.

Click on the Patient button and then select Patient Order Entry.
The CPOE window will appear.
Orders already entered with a Status of Active are listed in the box on the left. Once created, the system will automatically generate an order number.

- Select the type (category) of the order
- Verify and enter the date the order was given. It defaults to the current date.
- Identify the test or procedure to be performed
- Note any special instructions
- Explain why the item is being ordered
- Ordered items remain on this list until deleted
- When finished, click the red check Update button.
Chapter 9 – Clinical Decision Support

Meaningful Use requires that certified software provides reminders to the doctor. Only 1 rule was required for the current level of Meaningful use.

To turn this rule on, select Tools and click IntelliCare: SmartCare

The SmartCare rule box will appear. If the rule already exists, it will be listed. If it is not present, click on the New icon to create the rule. This will open the New SmartCare AI Rule window.
This rule will offer an Adjustment suggestion on the Objective window.
Set Select Source Data Category to Subjective.
Set Select Source Data to check to Complaint Region.
Set Select Verify Data Category to Objective.
Set Select Verify Data to check to Spine Region.
Click Save.

Close SmartCare (Red button with white X).

To see the SmartCare function, open a patient with Subjective complaints. Go to the Objective Window to view the SmartCare suggestions, which will look like this:
Meaningful Use demands that certified software provides patient education resources. By Medicare’s definition this is accomplished by giving basic information about a diagnosis, lab test result, or medication. This information is accessed by clicking on the appropriate button (DX Information, Lab Test Information, or Medication Information) in each window. You then have the opportunity to view the data on screen or print.

**Information Buttons**

On the Diagnosis Sets window, the button is located in the middle right side of the screen.

The Lab Report is for lab tests that are imported into the program and is accessed through the Exams icon list. The information button is in the lower right corner.

At the bottom of the Medication window, towards the lower left side of the screen, is the Medication information button.

Each Information button opens to the Medline Plus Connect service of the National Institutes of Health. In each window click on a specific item, then click the Information button to display information about that item. The information can be
printed for the patient. If the information is needed in Spanish, click the Espanol button on the Medline page to instantly translate the information.
Chapter 11 – EHR Reports

The EHR Reports are produced by going to Tools and select Reports.

When the Reports window opens, click on the + next to EHR. This opens the list of all the EHR reports.

Patient Reminder List

Medicare’s concept of patient reminders is that the office staff has a list to work from on patient items. It does require that 2 items must be in place for the reminders report to function.

In User Security, permission must be checked on to View EHR Audit Log
In the Patient Info window, a Communication Preference must be set.

To generate the Meaningful Use Patient Reminders report, click on Tools > Reports. Select the EHR Patient Reminder List from the EHR Report list.
This opens the EHR Data Selection Tool. On this window, select the criteria by which to choose the patient. Click on each tab to choose the criteria for the report. After the selections are complete, click the Display button.

The EHR Patient Reminder report will generate, and look like this:
Patient Lists

Meaningful Use requires that you are able to generate a list of patients that meet specific criteria that you can select. This report uses the same EHR Data Selection Tool as the Reminders List. Simply choose the criteria you want and click the Display button.

The report generates as a simple list of patient names, as shown here:
EHR Audit Log

The Audit Log report is a Meaningful Use requirement for certification. It provides you with a tool to know exactly who is doing what in your system. This report can NOT be edited. It logs every entry and change made in ChiroPadEMR. It will eventually be used by insurance auditors to review how you do things in your practice. Note that Medicare mandates that SOAP notes must be completed within 72 hours of the patient visit, and with this report, auditors will know if you are compliant with this rule. They will also know of every change and alteration that is made in the system.

Things to do to be compliant and NOT get problems from the EHR Audit Log report:

- ChiroSuiteEHR - Run the Missing Notes Report daily (not part of Meaningful Use). This lists every patient for which you have entered charges but do NOT have a completed SOAP note for that date of service. Make sure you complete your notes within 72 hours or less.
- If you need to add or edit something in a SOAP note, clearly label it as an addendum showing the date you are making the change, the reason for it, and what it is.
- When you create a note or entry from a paper record, clearly state that in the note and scan the paper document into the patient’s file.

EHR Automated Measure Calculation

The EHR Automated Measure Calculation requires the recording of specific data for each patient. Verify that the EHR MU prompts are NOT shut off in Tools > Settings > Preferences.

When the prompts appear, you have the option to check off items that contribute to the EHR reports.
Automated Measure Calculation is actually a series of little reports. Selecting this report enables you to choose the Measures that you want on the report.

Just click on each measure that you want included, or on All Reports and click Run.

After the report is run, it will be displayed on the screen.
EHR Clinical Quality Measures

This report generates the Clinical Quality Measures that Medicare considers to be significant. At some point in the future, this report, or portions of it, will need to be **electronically** submitted to Medicare or another government agency.

Select the measures you want to report and click Run.
Chapter 12 – Timely Access

Meaningful Use mandates that patients have timely electronic access to their accounts.

Creating an Updox account

This functionality requires that you open an account with Updox to create a Patient Portal. Go to the Updox website, www.updox.com and click on Free Trial.

Click on the button “Start Your 15 Day Free.”
From the list that appears, select ChiroPad to begin the registration process.

Step 1: Account Holder - The first part of the registration is to set up the account holder information.
Step 2: Practice Information – Enter the Practice information.

Updox offers the ability to have incoming faxes arrive in Updox. If you click on the button to port your number, this means that your faxes will NOT arrive directly in your office, but will go to your account on the Updox website. To keep your faxes arriving to your fax machine in your office, select the button entitled "I'll port my number later".

Updox offers the ability to send faxes through their system. The first 500 (incoming or outgoing) are included in the service. If you need more than 500 pages per month, there is the option to purchase faxing bundles in groups of 500 pages. If you are NOT going to use this service, just click Next.
The initial Updox account allows up to 3 users to have access to the account. Click the **Add another user** button to register the other staff members that will have access to the account. It is simply entering their names, emails and creating a password for each.

The last step in the registration process is to enter your credit card information. Use the scroll bar to complete the credit card form. When you are done, click the **Finish** button in the lower right corner.
Installing the ChiroPad Connector for Updox

The next step is to setup the Updox ChiroPad Connector. This requires downloading and installing Updox Central which can be downloaded from the following link: http://myupdox.com/central/Updox%20Central%20Install.msi

When prompted, click either Run or Open.

If you receive the following window, click Run.
The *Updox Central* installer will now start, click **Next** to continue.

Click **Next** to confirm the installation and begin the install.

After the installation has completed, click **Close**.
When the install is completed, there should now be an icon on the desktop for *Updox Central*.

Double click the **Updox Central** icon. If prompted, allow *Updox Central* to update itself by clicking **OK**.

---

**Configuring the ChiroPad Connector for Updox**

When opening *Updox Central* for the first time, it is necessary to setup some basic settings for the ChiroPad Connector to work effectively.

**General Tab**

After your account is setup you will receive an integration key from Updox. Once you have entered it in this window, click the **Verify** button.
The following message should be displayed, if you receive a different message, please contact Updox for assistance.

Now click on the **Plugins** tab.

**Plugins Tab**
Select *ChiroPad Connector* from the list of available plugins and click **Install** to install the connector.
From the list of Sites, select the site you wish to have Updox work with and click Close.

Now click on the **Running as a Service** tab.

**Running as a Service Tab**
Check **Run Updox Central as a service** and enter in a **Service Name** then click Close.

---

**Logging in to Updox**

Open Updox using the icon on the desktop.

Login with your email and password and click **Sign In**.

The Updox workspace will load and the connector will connect to the specified database from earlier.
If either of the Status dots is not green, please contact Updox for assistance.

**Verifying the ChiroPad Connector is Working**

To verify that the ChiroPad Connector is working as expected, click **Tools** and select **Address Book**.

Enter at least a single letter and click the **Search** button.

There should be a list of patients from ChiroPad EMR who match the entered search criteria. If you do not see any patients yet, please wait a few minutes and search again.

**Setting up the Patient’s Updox Patient Portal Account**

*NOTE: Verify that there is an email account in ChiroPad EMR for the patient or you will not be able to create a portal account.*

Select a patient from the Address Book
If not already selected, click on the **Patient/Portal** tab and click **Create Account**.

A portal account will be created for the patient and the account information will be displayed. An email will also be sent to the patient to complete the registration for the patient portal.
Creating a CCR file to send to the Updox Patient Portal

When you receive a request from a patient for electronic access to his/her account, open the patient file in ChiroPad EMR.

Click on the Patient button and select Export to CCR.

When prompted to display patient healthcare information, click No.
When prompted to view the file location of the generated file, click Yes. This will open the CCR_Docs folder.

It is still possible to manually locate the file by navigating to the Site folder of the site you are logged into (i.e. Main, Training, etc..) and open the CCR_Docs folder. Be sure to navigate to the path on the server as all files are stored on the server and not on a workstation.

Look for the CCR file based on the patient’s chart number, if there is more than one that matches, look for the file with the most recent modified date.

Drag and drop that file onto the Updox window. After the file has been sent to the Updox workspace, there will be a new message in the Inbox. The final step to send the CCR file to the portal is to click the Send To Portal button.

The file will now be accessible to the patient through the portal.
Clinical Summaries and Electronic Copy of Health Information are both related to exporting to the CCR format.

In ChiroPadEMR the patient file must be open. Click on the Patient button and select Export to CCR.

For a clinical summary, click **Yes**.

For the electronic copy of health information, click **No**.
Chapter 14 – Exchange Patient Summary Record

From the Patient Menu select Import to Patient File

When the import file opens, verify that at least 1 of the Load Options has been selected.
Then Click **Read File**. A browser window will open. Browse to an XML file in either CCD or CCR format. The file will automatically be parsed.

When done, click **Load to Database** to store the information into the Patient’s record.
Chapter 15 - Encryption and Integrity

Submitting or sending SOAP notes electronically requires that they be encrypted. This is accomplished by using the SOAP Note Batch Printing feature. It does not matter if a patient account is open or not. Click on the Tools button and select SOAP Note Batch Printing.

The Batch Printing window appears. Verify that Encrypt Files(s) is checked. Click the Select button to choose the notes to encrypt.
The selection window will pop up enabling the filtering of the patients. The filtering process can select a single patient or any number of patients.

Once the Notes have been selected, place a check in the Encrypt Files box and then click Export RTF Files. Now click on Verify RTF Integrity and click OK.

HIE Encryption can only be accomplished by sending the file through an encrypted connection.
In general, Chiropractors are excluded from the requirement to report on Immunizations. However, if there is a provider in your practice that does give immunizations, then the requirement must be fulfilled.

**Exclusion for Eligible Providers:** Exclusion in accordance with paragraph (a)(2) of this section. An EP who administers no immunizations during the EHR reporting period or where no immunization registry has the capacity to receive the information electronically.

You can fulfill the Immunization requirements by entering the information by clicking on the History button and selecting Immunizations.
1. Enter Immunization information and click Update

2. Click Export to HL7

3. Click Yes

4. Navigate to the Site folder of the site you are logged into (i.e. Main, Training, etc..) and open the HL7_Exports

5. Look for the HL7 file based on the patient’s chart number, if there is more than one that matches, look for the file with the most recent modified date.
Chapter 17 – PQRS Codes

The Physicians Quality Reporting System (PQRS) codes are NOT part of Meaningful Use. However, beginning in 2013 their use is **required in order to qualify for the Medicare stimulus** incentive payments. At this time, PQRS applies ONLY to Medicare patients and Medicare billing.

The Physicians Quality Reporting System (PQRS) is an assortment of codes used for billing Medicare in addition to the standard CPT codes. The PQRS codes tell Medicare that you have performed specific functions in your practice. PQRS codes are also called G-codes or CPT II codes. ChiroSuite EHR and its components of ChiroPadEMR and ChiroOffice are designed to make this task as smooth as possible for the office staff.

Use of the PQRS codes is mandatory for all Medicare providers beginning on January 1, 2015. Prior to that date it is “voluntary”. There are 3 major considerations:

1. As noted above, beginning on January 1, 2013 you CANNOT qualify for the Medicare stimulus incentive payments unless you are using the PQRS codes.

2. Using the PQRS codes in 2013 and 2014 will give you a bonus of 0.5% (that is half a percent) in your Medicare payments.

3. **If the PQRS codes are NOT used beginning on January 1, 2013** (yes, that is thirteen), then Medicare will reduce payments to you by 1.5% beginning on January 1, 2015. And the reduction in benefits will be increased each year for at least the following 2 years.

The PQRS codes tell Medicare that you are “meaningfully using” a certified electronic health record system to document each and every patient encounter (visit). In 2012 there were 3 categories of codes that were mandatory for use by Chiropractors. **For 2013 only 2 categories are mandatory**. A few other categories are required in order to comply with Meaningful Use. Some additional codes, although not required, should be used whenever you perform the service that they refer to.

PQRS codes are used in addition to the usual CPT codes and must appear on your billing as separate line items. **Paper claims should show a zero (0.00) charge. Electronic claims must show a fee, such as 0.01 (1 cent) in order to get past many electronic clearing houses.** Note that many clearing houses automatically delete any line item that has a 0.00 charge. When you submit electronically, there should be a TOSR discount set in the ChiroSuite EHR system so that as the fees for PQRS are created, the discount can be entered with minimal staff effort. This will keep patient balances accurate.

The PQRS codes have alternative names. Some are called “G” codes, others are referred to as CPT II.
Complying with the Mandatory and Required codes

Although the use of the PQRS codes is primarily in the billing, the doctor’s SOAP notes MUST document that the procedure that these codes refer to were done, or not, including the explanation as to why or why not. The Plan Window in ChiroPadEMR section of ChiroSuiteEHR includes SOAP note documentation items for PQRS. It may be necessary to activate (turn on) these items in the customization area of ChiroPadEMR. Linkage is in place so that selecting the PQRS items in ChiroPadEMR will generate the appropriate PQRS G-code on the ChiroOffice Transaction window.

PQRS for 2013 is NOT the Same as 2012

For 2013 there are 2 groups of PQRS codes that are mandatory from Medicare; in 2012 there were 3 groups. The third item that was required in 2012 must be shut off for 2013 because using it will result in rejection of claims. There are a few other codes that are required in order to comply with Meaningful Use, which are described later in this manual. There are many codes that are optional, based on the combination of [a] if you perform the specific service or function and [b] whether or not you want to report it.

The item to shut off for 2013 is the use of G8447 or G8448, the code that tells Medicare that the documentation was created using certified EHR software. In 2012, in order to simplify the entry of this code, it was tagged to 3 specific items in the Plan window of ChiroPadEMR which then generated G8447 or G8448 on the ChiroOffice Transaction window. Each of those items ended with “PQRS”.

So for 2013 do NOT use

- Adjustment 1-2 Regions PQRS
- Adjustment 3-4 Regions PQRS
- Adjustment 5 Regions PQRS

Shut off these 3 items by opening the ChiroPadEMR Customization section (figure 1).

Figure 1

Click on the plus (+) next to Plan, then click Modalities (figure 2).
From the Modality list, select the item and make it Inactive. Finalize the shut off by clicking Save. (figure 3)

The mandatory codes **MUST be used for at least 50% of Medicare claims** generated by the practice during calendar year 2013 or, beginning in 2015, Medicare will penalize the practice by reducing Medicare payments to the practice.

The 2 PQRS groups that are mandatory for 2013 are referred to as Meaningful Use Measure # 131 (Pain Assessment and Follow-up) and Measure # 182 (Functional Outcome Assessment). Although they sound similar, these groups are significantly different. Medicare uses terminology differently than doctors, so certain words and phrases that doctors think they understand means something totally different to the Medicare bureaucrats.

- **Pain Assessment and Follow-up** (Measure # 131) refers to the doctor assessing the patient for pain on each and every visit, **BEFORE performing any kind of care or treatment**. It is as simple as noting a 0 to 10 Pain Scale in the SOAP notes on the Subjective Complaint window (figure 4). This assessment is part of the evaluation that determines the course of action (follow-up plan) ON THAT VISIT.
Figure 4
Pain Assessment uses the following G-codes:

<table>
<thead>
<tr>
<th>Provider Action</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pain Assessment Documented as Positive AND Follow-up Plan Documented</td>
<td>G8730</td>
</tr>
<tr>
<td>Pain Assessment Documented as negative, No follow-up plan documented</td>
<td>G8731</td>
</tr>
<tr>
<td>Patient not Eligible for Pain Assessment for Documented Reasons</td>
<td>G8442</td>
</tr>
<tr>
<td>Pain Assessment Documented, Follow-up plan not documented, Patient not Eligible/Appropriate</td>
<td>G8939</td>
</tr>
<tr>
<td>Pain Assessment not Documented, Reason not Specified</td>
<td>G8732</td>
</tr>
<tr>
<td>Pain Assessment Documented as Positive, Follow-up Plan not Documented, Reason not Specified</td>
<td>G8509</td>
</tr>
</tbody>
</table>

- **Functional Outcome Assessment** (Measure 182) is providing the patient with a standardized outcome assessment form (such as Oswestry, Roland-Morris, Pain Disability Questionnaire, or any other standardized form). There must be proof that the patient completed the form (for example, the patient’s signature). The information from the Outcome Assessment form must be entered in the SOAP notes. This is done on the right side of the ChiroPadEMR Plan window where the form is identified and the score is defined as a raw number (#) or percentage (%) (figure 5).

---

**Figure 5**

Functional Outcome Assessment uses the following G-codes:

<table>
<thead>
<tr>
<th>Provider Action</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Functional Outcome Assessment and Care Plan Documented</td>
<td>G8539</td>
</tr>
<tr>
<td>Current Functional Outcome Assessment Documented, no Functional Deficiencies Identified, Care Plan not Required</td>
<td>G8542</td>
</tr>
<tr>
<td><strong>Functional Outcome Assessment and Treatment Plan documented within the previous 30 days</strong></td>
<td>G8942</td>
</tr>
<tr>
<td>Current Functional Outcome Assessment not Documented, Patient not Eligible</td>
<td>G8540</td>
</tr>
<tr>
<td>Current Functional Outcome Assessment not Documented, Reason not Specified</td>
<td>G8541</td>
</tr>
</tbody>
</table>
Current Functional Outcome Assessment Documented, Care Plan not Documented, Reason not Specified | G8543

Note that some items in the 2 assessment groups are boldfaced while others are not. The highlighted items are the ones that will be used the most commonly. However, when there is a patient that does NOT meet the criteria, the less frequent codes will need to be used.

There is one code in the Functional Outcome Assessment group that is italicized with stars next to its G-code. Medicare requires Chiropractors to clearly show that a Functional Outcome Assessment was performed at least once every 30 days while the patient is under Active Treatment, but for every regular office visit that is in-between the re-exams, Chiropractors must also show that the Functional Outcome Assessment was NOT done.

Each of these categories MUST be reported (shown on your claim) for every Medicare patient for every visit that includes CPT code 98940, 98941, or 98942.

The form must be given to the patient on the initial visit and at least once every 30 days while the patient is under Active Treatment, signified by the use of the AT modifier in the line item billing. Based on the Outcome Assessment form, Medicare expects to see a 10% or greater amount of improvement in the patient’s condition at the end of each month of Active Treatment. If there is less than a 10% amount of improvement over the course of 2 or more months, Medicare considers the treatment to be maintenance care. In a post payment audit, Medicare will require the doctor to refund the payments already made if the care given is deemed to have been maintenance care.

There are several Meaningful Use Measures that require the use of additional PQRS codes in the ChiroSuiteEHR system. Each practice is different so that each will find that only some of these are appropriate for the office. It may not be necessary to use all these codes; just use the ones that are appropriate for the practice and the patient. The PQRS codes required by ChiroSuiteEHR to complete Meaningful Use requirements are discussed in detail in Chapter 18 of this Manual. NOTE that in addition to the PQRS codes, there may also be requirements for specific ICD-9 diagnosis codes, CPT codes, and other items that MUST be present in the patient file. These ChiroSuiteEHR required PQRS codes include:

- Measure #317 Preventive Care Screening for High Blood Pressure
  - Measure #317 classifies the blood pressure in 3 categories:
    - **Normal** is when both the systolic and diastolic measurements are normal, that is the systolic is 119 or lower and the diastolic is 79 or lower
    - **Pre-hypertension** is when either number is slightly abnormal; systolic between 120 and 139; diastolic between 80 and 89 [SIDE NOTE: Medicare has now made almost everyone abnormal, since 120/80 is considered to be normal blood pressure]
    - **Hypertension** is when either number is significantly elevated; systolic of 140 or higher; diastolic of 90 or higher
  - G8783 Normal, no follow up needed
  - G8950 Pre-hypertension or hypertension with a follow up plan documented
  - G8784 Blood pressure was NOT documented because the patient is NOT eligible (patient already has an active diagnosis of hypertension; or patient refused to be measured; or patient is in a crisis in which taking blood pressure reading would jeopardize the patient
  - G8951 Abnormal blood pressure documented but the follow up is NOT documented because the patient is NOT eligible
  - G8785 Blood pressure was NOT documented and no reason was given
  - G8952 Abnormal blood pressure documented but the follow up is NOT documented, but NO reason is given
• **Measure # 128 for Body Mass Index (BMI)**
  - G8420 Calculated BMI normal
  - G8417 BMI above normal and follow-up plan documented
  - G8418 BMI below normal and follow-up plan documented
  - G8422 BMI NOT calculated, patient not eligible
    - Patient is not eligible if
      - On palliative/maintenance care
      - Pregnant
      - Refuses to be measured
      - Any medical reason that doctor documents explaining why BMI is inappropriate
      - Patient is in emergency health situation and checking BMI would result in delay of critical care
  - G8938 BMI calculated, patient not eligible for a follow-up plan
    - Patient is not eligible if
      - On palliative/maintenance care
      - Pregnant
      - Refuses to be measured
      - Any medical reason that doctor documents explaining why BMI is inappropriate
      - Patient is in emergency health situation and checking BMI would result in delay of critical care
  - G8421 BMI NOT calculated, no reason given
  - G8419 BMI calculated outside normal but NO follow-up plan

• **Measure # 64 for Asthma Assessment**
  - In addition to showing the appropriate diagnosis (ICD-9 code) and an appropriate examination (CPT) code, 2 CPT II codes must be used.
    - When the patient’s asthma is evaluated, use both
      - 2015F Asthma impairment Assessed
      - 2016F Asthma risk Assessed
    - When the asthma is NOT evaluated and there is no reason specified, then use the codes with the 8P modifier
      - 2015F 8P Asthma impairment NOT assessed, no reason specified
      - 2016F 8P Asthma risk NOT assessed, no reason specified

• **Measure # 231 for Asthma Tobacco Use Screening**
  - In addition to showing the appropriate diagnosis (ICD-9 code) and an appropriate examination (CPT) code
    - When tobacco use is assessed
      - 1031F Smoking status and exposure to second hand smoke in the home assessed
    - When tobacco use is NOT assessed
      - 1031F 8P Smoking status and exposure to second hand smoke in the home NOT assessed, no reason specified

• **Measure # 232 for Asthma Tobacco Use Intervention**
  - In addition to showing the appropriate diagnosis (ICD-9 code) and an appropriate examination (CPT) code, there are 2 codes that are required when the patient is a smoker or exposed to second hand smoke
    - 4000F or 4001F
      - 4000F Tobacco use cessation intervention, counseling
• 4001F Tobacco use cessation intervention, pharmacologic therapy
  • 1032F Current tobacco smoker or currently exposed to second hand smoke
  • When the Cessation Intervention is NOT performed and there is no reason specified, then use the codes with the 8P modifier
    • 4000F 8P Tobacco use cessation intervention, counseling NOT performed, reason NOT specified
    • 4001F 8P Tobacco use cessation intervention, pharmacologic therapy NOT performed, reason NOT specified
      o In addition to showing the appropriate diagnosis (ICD-9 code) and an appropriate examination (CPT) code,
        ▪ 1033F when the patient is NOT eligible because the patient is a non-smoker and is NOT exposed to second hand smoke
      o G8751 Smoking status and exposure to second hand smoke NOT assessed, reason NOT given
• Measure # 126 for Diabetic Foot Exam
  o In addition to showing the appropriate diagnosis (ICD-9 code) and an appropriate examination (CPT) code, one of the following PQRS codes should be used
    ▪ G8404 Lower extremity neurological exam performed and documented
    ▪ G8406 Patient NOT eligible for lower extremity neurological exam
    ▪ G8405 Lower extremity neurological exam NOT performed
• Measure # 134 for Depression Screening
  o G8431 Positive screen for clinical depression with a documented follow-up plan
  o G8510 Negative screen for clinical depression, follow-up plan NOT required
  o G8433 Screening for clinical depression NOT documented, patient not eligible
  o G8940 Screening for depression documented, follow-up plan NOT documented, patient NOT eligible
  o G8432 Screening for depression NOT documented, reason not given
  o G8511 Screening for depression documented, follow-up plan NOT documented, reason NOT given
• Measure # 226 for Tobacco Use Cessation (NON-asthma patient)
  o 4004F Patient screened for tobacco use AND received cessation intervention (counseling or pharmacotherapy)
  o 1036F Patient screened for tobacco use and is a NON-user
  o 4004F 1P Documentation of medical reason for not screening (for example, limited life expectancy)
  o 4004F 8P Tobacco screening or cessation intervention NOT performed, reason NOT specified

Additional specific details about these PQRS codes is available on the Medicare (CMS) website. The data can be downloaded in a PDF format. The specific document is the 2013_PQRS_MeasureSpecManual.pdf which is 637 pages.

Using the PQRS codes
As soon as you have installed certified ChiroSuiteEHR version 17.0 or certified ChiroPadEMR version 17.0, start using the PQRS codes on the claims you submit to Medicare. You will eventually find that some specific codes are used frequently while some may never be used. Note that Medicare revises the PQRS codes annually, so be vigilant to use the correct code.

• Pain Assessment Prior to Initiation of Treatment – use only 1 of the following on each visit
- G8730 – You assessed the patient for pain AND documented a follow up plan that specifies when you will reassess the patient for pain
- G8731 – You assessed the patient for pain
  - but did NOT write out a follow up plan
  - but DID document a valid reason why no follow up plan was developed
    - valid reasons for no follow up plan for pain are
      - patient had no pain
      - patient’s condition was NOT related to his/her pain
- G8509 – You assessed the patient for pain
  - But did NOT document a follow up plan
  - And did NOT give a valid reason for not creating a plan
- G8442 – You did NOT assess for pain but DID document why in the patient record
  - Valid reasons for NOT assessing pain
    - Patient refusal
    - Mental or physical incapacity
    - Need for urgent care
    - The pain was assessed during a recent visit and it is not yet time for the scheduled reassessment
- G8732 – You did NOT assess for pain AND you did NOT document why

• Functional Outcome Assessment in Chiropractic Care – as the name states, it is specific to Chiropractic
  - You must have the patient complete a functional outcome assessment form at least once every 30 days while the patient is under Active Treatment, such as
    - Oswestry Disability Index
    - Roland Morris Disability/Activity Questionnaire
    - Neck Disability Index
    - Pain Disability Questionnaire
    - Any other standardized functional outcome assessment form that you prefer
  - You must be able to prove that the patient completed the form, that is, it MUST be signed by the patient
  - You must report both
    - when the functional outcome assessment was performed (every initial exam and re-exam) and
    - when it was NOT done (every regular office visit between exams)
- G8539 – on each visit when
  - the patient completed a functional outcome assessment form
  - you documented a care plan
- G8542 – on each visit when
  - A functional outcome assessment form was completed by the patient
  - But you did NOT document a care plan for a valid reason, such as
    - Patient had NO functional deficiency
- G8543 – on each visit when
  - A functional outcome assessment form was completed by the patient
  - But you did NOT document a care plan AND
  - You did NOT explain why it was not documented
- G8942 – on each visit when
  - A functional outcome assessment was completed within the previous 30 days
- G8540 – on each visit when
  - A functional outcome assessment form was NOT completed by the patient
  - But you did document a valid reason why it was not done, such as
- Having a current functional assessment in the patient file that was performed within the past 30 days
- The patient refused to complete the form
  o G8541 – on each visit when
    ▪ A functional outcome assessment form was NOT completed by the patient
    ▪ And you did NOT document a reason explaining why it was not done

In the ChiroPadEMR section of ChiroSuiteEHR, enter the PQRS items on the Plan window of ChiroPadEMR. The PQRS codes should be listed in the Modality column. Depending on the item, the region to select may be ‘patient’, or a specific body part.

Activating the PQRS codes in ChiroPadEMR

The PQRS codes have been added to the ChiroPadEMR modalities list, but were set to Inactive. They will not be visible in the Modalities column of the ChiroPadEMR Plan window on your computer until they are activated. A new PQRS category has been added to the Procedure Catalog in the ChiroOffice section of ChiroSuiteEHR. This includes a large number of PQRS codes that could be used in Chiropractic practice, even if they are not mandatory. The ChiroOffice Procedure Catalog is discussed later in this chapter.

With ChiroPadEMR open, click on Tools and select Customize
When the Customization menu opens, click on the + (plus sign) next to Plan and select Modalities.

The Customize Plan Verbiage window will appear.

At the bottom left, click on the check box to Show Inactive. Now scroll through the list and find each Inactive item that you will need in your SOAP notes. Each Inactive item will have a check in the Inactive box. Simply uncheck and click the Save icon on the upper left under the words Modality Listing.

**Link the Codes from ChiroPadEMR to ChiroOffice**

It is necessary to activate the PQRS codes in ChiroOffice so that your selection in ChiroPadEMR will automatically create the billing line on the ChiroOffice transaction window.
Open ChiroOffice, click on Tools, select Catalogs, and choose the Procedure catalog.

Next, click on the Treatment Plan button at the top of the IntelliCoded; Treatment Plans window.
The Treatment Plans window opens. From the Treatment Plans box on the upper left, scroll through the list and find each PQRS item that needs to generate a line item in the billing.

After identifying each item in the upper Treatment Plan box, select it by single clicking on it so it is highlighted. Look at the Procedures in Plan box on the lower left. If the Procedures in Plan box is empty, then that ChiroPadEMR modality will NOT generate anything in ChiroOffice. Now select the appropriate CPT and/or PQRS code(s) from the Available Procedures list on the right. Note that the Available Procedures list offers 3 sort options by clicking on the column heading. Click CPT to sort by CPT code, click Description to sort alphabetically. When you find the correct CPT code(s), click on it to highlight it, and then click on the left arrow to move it into the box on the lower left labeled Procedures in Plan.

When you close the Treatment Plans window, the entries are saved and you have linked the ChiroPadEMR modality selection to the ChiroOffice transaction billing. This means that selecting the modality in ChiroPadEMR will enter the appropriate line item and charges on the Transaction window in ChiroOffice.

For purposes of the Medicare Stimulus requirements, the correct documentation in ChiroPadEMR will produce the appropriate PQRS code(s) in ChiroOffice when everything has been linked.

Activating the PQRS codes in ChiroOffice

To verify that the PQRS codes are in your ChiroSuiteEHR system, open ChiroOffice and go to Tools and select Reports.
From the Reports list, click on the + next to Catalogs and choose the Procedure Master List.

The pop up selector appears. Select the Status as Both and the Type as Service

The report that generates should be approximately 20 pages. It is sorted alphabetically by category. The PQRS category will be towards the end of the report and list the PQRS (CPT II and G) codes that are in the system. Next to each code it will identify the status as either Active or Inactive. There should be about 1 ½ pages of the PQRS codes. Print the pages that these codes appear on so you can clearly review them and
determine which ones are appropriate for your practice. For those that you will use that are Inactive, go to Tools, select Catalogs, and open the Procedures Catalog. Find each Inactive PQRS code and change its status to Active, and click Save.

For more information about PQRS, there are multiple resources available for you:

- The American Chiropractic Association provides a wealth of understandable information on the mandatory codes for chiropractors. Go to http://www.acatoday.org/pqrs
- Visit the Medicare (CMS) website at https://www.cms.gov/PQRS
- Contact your state association. If the state association has set up a Medicare committee, it may have materials that will help you with PQRS.
Chapter 18 - How to Get the Meaningful Use Numbers Right

Generating the reports for Meaningful Use has very specific reporting requirements. This chapter will show you how to document properly in order to create each of the Clinical Quality Measures and Automated Measure Calculations.

**Adult Blood Pressure/Hypertension Screening**

The patient’s blood pressure must be measured and recorded in the Physical Exam window. To access the Physical Exam area, with the patient account open, click on either the Objective icon or the Exams button.

From the Objective window, click on the button for Physical...
Or from the Exams button, select Physical

After measuring the Blood Pressure, enter it in the appropriate location. If the blood pressure was measured in both arms, enter each finding. Be sure to click the save icon after making the entry.

As soon as the SOAP note is generated, this information will generate in the documentation. If it does not, verify that the Note Options are set correctly on the documents window.
However, just checking the blood pressure is NOT enough for Meaningful Use. The appropriate diagnosis code must be used. The Diagnosis Window is accessed in the Assessment section. Click the Assessment icon. When the Assessment Window opens, click on the Diagnosis Sets tab.

Now verify that the correct ICD9 diagnosis code is in the patient’s Diagnosis window. If the blood pressure was normal, use code V81.1 Screening for Hypertension. If the blood pressure is elevated, use one of the codes in the 401 series, either as a stand-alone item or together with the V81.1.

- 401.0 Malignant Essential Hypertension
- 401.1 Benign Essential Hypertension
- 401.9 Unspecified Essential Hypertension
  - This applies to hypertension when there is NO pre-existing kidney disease or any other known organic cause.

The combination of recording the blood pressure and using the ICD 9 code is what will generate the numbers and percentages for the hypertension blood pressure screening for Meaningful Use. In your billing, make sure the appropriate PQRS (G codes and/or CPT II) codes are used. Usually only one, and sometimes 2, of these codes are used on one visit. These codes include:

- G8675 Hypertension systolic greater than 140 mmHg
- G8676 Hypertension diastolic greater than 90 mmHg
- G8677 No hypertension systolic less than 130 mmHg
- G8678 Potential hypertension systolic between 130 to 139 mmHg
- G8679 No hypertension diastolic less than 80 mmHg
- G8680 Potential hypertension diastolic between 80 to 89 mmHg
- 4050F Hypertension plan of care documented

---

**Adult Weight Screening and Follow-Up AND Weight Assessment and Counseling for Children**

There are 2 Weight Screening Meaningful Use categories that are divided into a few sub items.

- Adult Weight Screening and Follow up
  - Adults over age 65
  - Adults 18 to 64
  - Height and weight checked within the last 6 months
  - On a weight control plan if underweight or overweight
  - Having a nutritional evaluation and/or assessment
  - Weight control nutrition counseling

- Weight Assessment and Counseling for Children
  - Children between 2 and 16
  - Children between 2 and 10
  - Children between 11 and 16
  - Height and weight checked within the last 6 months
  - On a weight control plan if underweight or overweight
  - Having a nutritional evaluation and/or assessment
  - Weight control nutrition counseling
  - Weight control physical exercise counseling

The information for both of these Meaningful Use items comes from the same locations in ChiroPadEMR.

Open a patient account and go to the Patient Info area by clicking on the Patient Info icon.

The patient’s age is calculated from the date of birth entered in the Patient Information window. Enter the patient’s date of birth and click the Save icon.
In the Physical Exam window, enter the patient’s height and weight. ChiroPad EMR will automatically calculate the patient’s body mass index (BMI). If it is abnormal, the system will show you.

Now go to the Modalities list on the Plan window.

In the Modalities window there are 3 PQRS items that should be selected in order to document the Meaningful Use items.

1. BMI (body mass index). Be sure to select the correct item for the visit.
   a. BMI screening normal – G8420
   b. BMI above normal (with a plan) – G8417
   c. BMI below normal (with a plan) – G8418
   d. BMI outside norm No followup – G8419
   e. BMI patient not eligible – G8421
2. Counseling for Nutrition
   a. 97802 for 15 minutes for initial nutrition consultation; up to 6 units (90 minutes) is acceptable; anything over 6 units is not covered
   b. 97803 for 15 minutes for subsequent nutrition consultation; up to 6 units (90 minutes) is acceptable; anything over 6 units is not covered

3. Counseling for Physical Activity - V65.41

The selection of these items provides the documentation in ChiroPadEMR and generates the PQRS items in the Transaction window of ChiroOffice.

**Asthma Assessment**

The Asthma Assessment includes patients between the ages of 5 and 40. ChiroSuiteEHR calculates age based on the date of birth entered in the Patient Information window.

![Asthma Assessment Image]

The patient must have an ICD diagnosis code between 489 and 494 entered in the Diagnosis window. The most commonly used codes for Asthma are from 493.00 to 493.92.

- 493.00 Asthma extrinsic unspecified
- 493.02 Asthma extrinsic with acute exacerbation
- 493.10 Asthma intrinsic unspecified
- 493.12 Asthma intrinsic with acute exacerbation
- 493.20 Asthma chronic obstructive unspecified
- 493.22 Asthma chronic obstructive acute exacerbation
- 493.81 Asthma exercise induced bronchospasm
- 493.82 Asthma cough variant
- 493.90 Asthma unspecified
- 493.92 Asthma unspecified with acute exacerbation

Patient complaints in the Subjective Complaint window must include daytime asthma symptoms or nighttime asthma symptoms. Selecting the simple “asthma” item does not meet the criteria for Meaningful Use. This must be selected from the Anterior Chest or Posterior Upper Back area on the Subjective Complaints window.
In ChiroPadEMR modalities, select one or more of the following items to document this correctly.

- Asthma Assessment – 1005F
- Asthmatic non-smoker and no second hand smoke – G8687
- Asthma symptoms evaluated – 1005F
- Asthmatic not eligible – G 8691
- Asthma symptoms not evaluated - 1005F-8P
- Asthma tobacco cessation counseling - 4000F
- Asthma tobacco cessation no counseling - 4000F-8P
- Asthma tobacco smoker or second hand - G8686
- Asthmatic’s tobacco use not assessed - G8693
- Asthma smoker/second hand use - G8690
- Asthmatic’s smoking not assessed - G8689

**Tobacco and Tobacco Use Cessation Intervention**

Tobacco use applies to all patients 17 and older that have had a physical exam within the reporting period. ChiroSuiteEHR calculates age based on the date of birth entered in the Patient Information window.
The patient’s tobacco use is recorded in the History section. Go to the Health History.

Click on the Health History icon and then the Prior Illness tab. Now select and save the appropriate Smoking Status item. For Meaningful Use, be sure to use the Smoking Status selector and NOT the upper Smoking box.

In ChiroPadEMR modalities, scroll down and select one or more of the following items to document that you counseled and provided care for the patient to stop using tobacco.

- Counseling tobacco cessation 3 to 10 minutes - 99406
- Counseling tobacco cessation 10 minutes or longer - 99407
- Tobacco cessation gum - S4995
- Tobacco cessation nicotine patch
- Tobacco cessation smoke deter (homeopathic)
- Tobacco cessation zero nicotine herbal patch

**Childhood Immunization Status**

*NOTE: Chiropractors are exempted from having to report immunizations!!*

This Meaningful Use item is for children between the ages of 1 and 2. ChiroSuite EHR calculates age based on the date of birth entered in the Patient Information window.

Immunization information is entered in the Immunization window of the History section. The child is supposed to have received the following vaccines:
- DTap
- IPV
- MMR or its components
- Hepatitis B
- VZV
- Pneumo
- Hepatitis A
- Rotavirus
- Influenza

**Flu Immunizations for Patients 50 and older**

*NOTE: Chiropractors are exempted from having to report immunizations!!*

This Meaningful Use item is for adults over the age of 50 that are not allergic to the flu vaccine. ChiroSuiteEHR calculates age based on the date of birth entered in the Patient Information window.
Immunization information is entered in the Immunization window of the History section. One of the following must be selected:

<table>
<thead>
<tr>
<th>CVX Code</th>
<th>Short Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>Influenza, whole</td>
</tr>
<tr>
<td>88</td>
<td>Influenza, unspecified formulation</td>
</tr>
<tr>
<td>135</td>
<td>Influenza, high dose seasonal</td>
</tr>
<tr>
<td>140</td>
<td>Influenza, seasonal, injectable, preservative free</td>
</tr>
<tr>
<td>141</td>
<td>Influenza, seasonal, injectable</td>
</tr>
<tr>
<td>144</td>
<td>Influenza, seasonal, intradermal, preservative free</td>
</tr>
</tbody>
</table>

**Low Back Pain: Use of Imaging Studies**

This is for Patients between the ages of 18 and 49. ChiroSuiteEHR calculates age based on the date of birth entered in the Patient Information window.

In the patient diagnosis file, at least one of the following ICD codes must be present:

- 353.4
- 355
- 648.7
- 721.3
- 721.42
- 722.52
- 724.2
- 724.9
- 739.3
- 846
- 847.2
- 953.2
In the DIR (diagnostic imaging report), there must be an entry for either/both pelvic or lumbar imaging dated within 28 days of the diagnosis. Select Lumbar or Pelvic, or one of the combination regions that includes lumbar or pelvic, from the Regions list. Obviously, enter the view(s) and findings and then save the entries.

On the Plan window, select the x-ray item that is appropriate for the service you performed.
Diabetes: Foot Exam

To qualify for this Meaningful Use item, the patient must have a diagnosis of diabetes and be taking diabetes medication. Here is a list of the applicable diabetes diagnoses. Be sure to use only one!

- 250.00 Diabetes mellitus without mention of complication, type II or unspecified, not stated as uncontrolled
- 250.01 Diabetes mellitus without mention of complication, type I juvenile, not stated as uncontrolled
- 250.02 Diabetes mellitus without mention of complication, type II or unspecified, uncontrolled
- 250.03 Diabetes mellitus without mention of complication, type I juvenile, uncontrolled
- 250.10 Diabetes with ketoacidosis, type II or unspecified, not stated as uncontrolled
- 250.11 Diabetes with ketoacidosis, type I juvenile, not stated as uncontrolled
- 250.12 Diabetes with ketoacidosis, type II or unspecified, uncontrolled
- 250.13 Diabetes with ketoacidosis, type I juvenile, uncontrolled
- 250.21 Diabetes with hyperosmolarity, type I juvenile, not stated as uncontrolled
- 250.22 Diabetes with hyperosmolarity, type II or unspecified, uncontrolled
- 250.23 Diabetes with hyperosmolarity, type I juvenile, uncontrolled
- 250.30 Diabetes with other coma, type II or unspecified, not stated as uncontrolled
- 250.31 Diabetes with other coma, type I juvenile, not stated as uncontrolled
- 250.32 Diabetes with other coma, type II or unspecified, uncontrolled
- 250.33 Diabetes with other coma, type I juvenile, uncontrolled
- 250.40 Diabetes with renal manifestations, type II or unspecified, not stated as uncontrolled
- 250.41 Diabetes with renal manifestations, type I juvenile, not stated as uncontrolled
- 250.42 Diabetes with renal manifestations, type II or unspecified, uncontrolled
- 250.43 Diabetes with renal manifestations, type I juvenile, uncontrolled
- 250.50 Diabetes with ophthalmic manifestations, type II or unspecified, not stated as uncontrolled
- 250.51 Diabetes with ophthalmic manifestations, type I juvenile, not stated as uncontrolled
- 250.52 Diabetes with ophthalmic manifestations, type II or unspecified, uncontrolled
- 250.53 Diabetes with ophthalmic manifestations, type I juvenile, uncontrolled
- 250.60 Diabetes with neurological manifestations, type II or unspecified, not stated as uncontrolled
- 250.61 Diabetes with neurological manifestations, type I juvenile, not stated as uncontrolled
- 250.62 Diabetes with neurological manifestations, type II or unspecified, uncontrolled
- 250.63 Diabetes with neurological manifestations, type I juvenile, uncontrolled
- 250.70 Diabetes with peripheral circulatory disorders, type II or unspecified, not stated as uncontrolled
- 250.71 Diabetes with peripheral circulatory disorders, type I juvenile, not stated as uncontrolled
- 250.72 Diabetes with peripheral circulatory disorders, type II or unspecified, uncontrolled
- 250.73 Diabetes with peripheral circulatory disorders, type I juvenile, uncontrolled
- 250.80 Diabetes with other specified manifestations, type II or unspecified, not stated as uncontrolled
- 250.81 Diabetes with other specified manifestations, type I juvenile, not stated as uncontrolled
- 250.82 Diabetes with other specified manifestations, type II or unspecified, uncontrolled
- 250.83 Diabetes with other specified manifestations, type I juvenile, uncontrolled
- 250.90 Diabetes with unspecified manifestations, type II or unspecified, not stated as uncontrolled
- 250.91 Diabetes with unspecified manifestations, type I juvenile, not stated as uncontrolled
- 250.92 Diabetes with unspecified manifestations, type II or unspecified, uncontrolled
- 250.93 Diabetes with unspecified manifestations, type I juvenile, uncontrolled

Enter the diabetes diagnosis on the Diagnosis window.

In the Prescription section, Medications window, the patient must be taking at least one of the following medications:
- Actoplus MET (pioglitazone-metformin)
- Onglyza (saxagliptin)
- Novolin 70/30 (insulin nph & regular human)
- Diabeta (glyburide)

In the Plan window, select the Diabetic Foot Exam.
At least one of the following CPT codes must be used on the date of service when the diabetic foot exam is performed:

Most commonly used codes by Chiropractors are from 99201 to 99215

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Code</th>
<th>Description</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>11042</td>
<td>99201</td>
<td>99324</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11043</td>
<td>99202</td>
<td>99325</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11044</td>
<td>99203</td>
<td>99326</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11055</td>
<td>99204</td>
<td>99327</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11056</td>
<td>99205</td>
<td>99328</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11057</td>
<td>99212</td>
<td>99334</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11719</td>
<td>99213</td>
<td>99335</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11720</td>
<td>99214</td>
<td>99336</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11721</td>
<td>99215</td>
<td>99337</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11730</td>
<td>99304</td>
<td>99341</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11740</td>
<td>99305</td>
<td>99342</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>97001</td>
<td>99306</td>
<td>99343</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>97002</td>
<td>99307</td>
<td>99344</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>97597</td>
<td>99308</td>
<td>99345</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>97598</td>
<td>99309</td>
<td>99347</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>97802</td>
<td>99310</td>
<td>99348</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>97803</td>
<td></td>
<td>99349</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>99350</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

There are PQRS codes that apply to the diabetic foot exam:

- **G8404**: Lower extremity neurological exam performed and documented
- **G8406**: Clinician documented that patient was not an eligible candidate for lower extremity neurological exam measure
- **G8405**: Lower extremity neurological exam not performed
- **G8675**: Diabetic foot exam

**Anti-Depressant Medication Management**

This is for patients 18 and older that are taking anti-depressant medication. ChiroSuiteEHR calculates age based on the date of birth entered in the Patient Information window.
The patient must have an ICD code diagnosis of depression using codes between 296.3 and 296.36. This is entered in the Diagnosis Window.
At least one of the following medications must be in active use by the patient in order to qualify for Meaningful Use:

- Paxil (paroxetine)
- Prozac (fluoxetine)
- Effexor (venlafaxine)
- Buspar (buspirone)
- Pertofrane (desipramine)
- Luvox (fluvoxamine)
- Sinequan (doxepin)
- Tofranil (imipramine)
- Pamelor (nortriptyline)
- Elavil (amitriptyline)
- Desyrel (trazodone)
- Wellbutrin (bupropion)
- Ludomil (maprotiline)
- Cymbalta ( duloxetine)
- Norpramin (desipramine)
- Endep (amitriptyline)
- Celexa (citalopram)
- Anafranil (clomipramine)
- Adapin (doxepin)
- Zoloft (sertraline)
- Pristiq (desvenlafaxine)
- Lexapro (escitalopram oxalate)
- Edronax, Vestra (reboxetine)
- Vivactil (protriptyline)
- Serzone ( nefazodone)
- Parnate (tranylcypromine)
- Surmontil (trimipramine)
- Remeron (mirtazapine)

The medication(s) must be listed in the patient’s Medication window in the Prescriptions section.

The PQRS codes that apply to depression are:

- G8510 – Depression screen negative
- G8431 – Depression screen evaluation and treatment plan
- G8511 – Depression screen with no plan
- G8432 – Depression screen not documented with no reason given
- G8433 – Depression screen not eligible

Automated Measure Calculations

The automated measure calculations are determined by the number of patients for whom you have performed a specific activity or service compared to the number of patients in your practice for the past year. In some instances, the comparison is with a subgroup of your patients.

1. **Patients with a diagnosis:** The calculation is based on the number of patients given a diagnosis within the reporting period compared to the total number of patient visits during the reporting period. Each time a new diagnosis is entered, this measure is being fulfilled.
2. **Patients on Medication:** The calculation is based on the number of patients given medication (prescription, over the counter, supplements, herbals, nutriceuticals, naturopathic, and homeopathic, etc.) within the reporting period compared to the total number of patient visits during the reporting period. If you do NOT know what medications the patient is taking, from the Medication list, select either NKM for No Known Medications or NKD for No Known Drugs. Note that the Meaningful Use definition of Medications includes all nutrition items other than real food including but not limited to supplements, herbals, nutriceuticals, homeopathic and naturopathic substances.
3. **Patients with Medication Allergies Assessed:** The calculation is based on the number of patients with allergies to medications compared to the total number of patient visits during the reporting period. This information is entered on the Allergies tab of the Medication window. Note that the Meaningful Use definition of Medications includes all nutrition items other than real food including but not limited to supplements, herbals, nutriceuticals, homeopathic and naturopathic substances. If the patient has allergies to any of these items, they must be included in the Medication Allergies. If the patient does NOT have any Medication Allergies, select either NKMA for No Known Medication Allergies or NKDA for No Known Drug Allergies.

4. **Patients with Demographics Collected:**
This Meaningful Use requirement compares all patients that have the following demographic data collected with the total number of patients in the reporting period. The demographic data must include the patient’s sex, date of birth, communication preference, ethnicity and race. Note that the selections for ethnicity and race are government lists and can NOT be changed. This data is entered in the Patient Info window.
5. **Patient Education:**
Compliance with this item requires that you print and give patient education materials to the patient. This is accomplished on the Diagnosis, Lab Test, and Medications windows by clicking on the information button. **Be sure to click on an ID or name of the desired item to print prior to clicking on the information button.**

Note that this button works ONLY when the computer is connected to the internet. Clicking on the information button opens the Medline Plus website from the National Institutes of Health. On this website you will find information that is designed for patients. Simply print it. And if you need it in Spanish, just click the Español button. The Medline Plus website will instantly translate the patient education material into Spanish.

6. **Computerized Physician Order Entry (aka CPOE):**
CPOE produces a calculation based on the number of patients for whom medications were ordered and is compared to the number of patients taking medications. Chiropractors and other health care providers that produce fewer than 100 prescriptions per month may be exempted from this requirement, at this time. Stages 2 and 3 will increase the number of areas, other than medications, that would fall into CPOE. If you do write more than 100 prescriptions per month, then you will need to sign up for the ChiroPad eRx e-prescribing service which will also produce the needed data for this Meaningful Use requirement.

Once CPOE is open, you need to select the appropriate Type (radiology, laboratory, physical therapy. For each item, select the Test or Procedure, enter instructions, note the indications for the item and click Update.
7. **Patients over age 2 with BMI and Blood Pressure Assessed**

The entry for this data is made on the Physical Exam window. Enter the height and weight, and ChiroPadEMR automatically calculates the Body Mass Index (BMI). Enter the Baseline Blood Pressure, either right or left or both. The system will calculate the reporting percentage for all patients over the age of 2. This is adequate for Meaningful Use. If the patient is found to have high blood pressure (hypertension), then you may want to include pre-adjustment and post-adjustment measurements to document how your care and treatment is affecting the patient’s blood pressure.

The patient’s age is calculated from the Date of Birth (DOB) entry on the Patient Info window.
8. **Patients Who Smoke**

The calculation is based on the smoking statistics for all patients 13 years of age and older. The patient’s age is calculated from the Date of Birth (DOB) entry on the Patient Info window.

Click on the Health History icon and then the Prior Illness tab. Now select and save the appropriate Smoking Status item. **For Meaningful Use, be sure to use the Smoking Status selector and NOT the upper Smoking box.**
9. **Incorporate Lab Tests into the EHR system**
   Since lab tests are not yet officially ordered through CPOE, the reporting will be 100% for this Meaningful Use item.

10. **Electronic copy of patient health info**
    Patients have the right to request an electronic copy of their health records. To meet the requirements of Meaningful Use, it is necessary that this electronic copy is provided to the patient within 3 days of the request through a Patient Portal. ChiroSuiteEHR uses the Updox Patient Portal to fulfill this mandate. When you receive your first request for an electronic copy, contact Updox and subscribe to their service. Upon receiving a request, enter the patient file and upload it to the Updox website. Make a note about the request and as you close the patient file a Meaningful Use Measure Calculation Checklist will appear. Check off the appropriate item, Patient File Sent to Portal within 4 days to let the system know that you have completed this item on time. Note that in order to comply with the patient’s request for an electronic copy, you must use the Updox Patient Portal and check the appropriate item(s) in this box. Note that it is necessary to have the patient’s e-mail address so Updox can make the connection with the patient. Additionally, if you use another Patient Portal, you can still check off Patient File Sent to Portal within 4 days if you have performed this action.

![Image](image.png)

If the checklist does not appear when closing patient accounts, verify that specific settings have been turned on. Go to Tools > Settings.

![Image](image.png)

When the Settings window appears, click on the Preferences button and verify that *Disable EHR MU Prompts* is not checked.
11. **Medication Reconciliation Performed:**

   **NOTE:** Chiropractors and other health care providers are NOT exempt from this requirement if they provide nutrition, herbal, homeopathic, naturopathic or over the counter substances to patients, or if they discuss medications with the patient.

Medication reconciliation is the process of comparing planned medications with all of the medications that the patient has been or is currently taking. This reconciliation is done to prevent errors such as omissions, duplications, dosing errors, or drug interactions. It should be done at every transition of care in which new medications are ordered or existing orders are rewritten. Transitions in care include changes in setting, service, practitioner or level of care. The medication reconciliation process comprises five steps:

1. Develop a list of current medications being taken by the patient
2. Develop a list of medications to be prescribed
3. Compare the medications on the two lists
4. Make clinical decisions based on the comparison
5. Communicate the new list to appropriate caregivers and to the patient.

At this time, medication reconciliation applies to include all substances used to improve or treat any kind of health problem. These substances cover over the counter items including allopathic, homeopathic, naturopathic, herbals, nutriceuticals, and supplements. So if you use nutrition in your practice, this is a requirement.

Completing this Meaningful Use item at this time is based on 2 criteria being checked on the Meaningful Use Checklist. The 2 criteria are [1] Medical Reconciliation Performed and [2] Patient was referred to another provider.

12. **Patient Summary: Discharge Info Provided:**

   This item is broken down into 3 different categories.
   1. You produced a summary of the visit
a. It is critical that you create a SOAP note for the patient’s date of service. Your SOAP note is the Patient Summary. Ask the patient if he/she would like a copy of the note. The fact that you produced the SOAP note means that you have fulfilled this Meaningful Use requirement and you should place a check in the box for Patient Summary, whether or not the patient was discharged.

2. The patient was discharged from active treatment:
   a. If the patient was discharged from active treatment, even if he/she is continuing on maintenance or supportive care, be sure that this is recorded in your SOAP note.

3. The patient was referred to another provider.
   a. In the event that you referred the patient to another provider, whether or not the patient was discharged from active treatment, place a check in the box for Patient was referred out.

13. **Timely Access - Patient File Sent to Portal w/in 4 days:**
When a patient requests an electronic copy of his/her records, the copy of the patient file is accessed through a Patient Portal. The Patient Portal functions in the ChiroSuiteEHR programs are provided by Updox. When the patient requests the records, the file is uploaded to Updox and Updox emails an invitation to the patient to connect and access the file. The Meaningful Use requirement is that you must upload the file so it is available to the patient within 4 days of receiving the request. Whenever this is completed, place a check in the box for Patient File Sent to Portal w/in 4 days. Additionally, if you use another Patient Portal, you can still check off Patient File Sent to Portal within 4 days if you have performed this action.

14. **Clinical Summaries:**
In addition to the Timely Access function, patients may also request a clinical summary be sent to themselves or another health care provider. The clinical summary is either all your SOAP notes for the date range requested by the patient, OR a narrative report that provides the clinical information about the patient. **Whenever a SOAP note is completed and produced, OR whenever a narrative report is generated, place a check in the box for Produced Clinical Summary w/in 3 days.**
15. **Patient Reminders:**

The Meaningful Use requirement for Patient Reminders is NOT what its name implies. This is a report that is generated to remind the office staff of things that should be done. It only applies to patients under the age of 5 and over the age of 65. Patients between the ages of 6 and 64 are not counted in the calculation. To create this report, go to Tools > Reports.

When the Reports menu opens click on the plus (+) next to EHR to expand the EHR Report list. Select the EHR Patient Reminders List by clicking on it.

The EHR Data Selection Tool opens. To produce the Patient Reminders report, it is necessary to select the criteria to generate the report. Place a dot in the Specify Ages and then set the age range to younger than 5 and older than 65.
The report generates when you click the Display button. At this time, this is all that is needed to complete the Patient Reminders required by Meaningful Use.
16. **Generate and Transmit Electronic Prescriptions:**

This is for those offices that write at least 100 medication prescriptions per month. This means that there is an MD, DO, Physician Assistant, Nurse Practitioner or other provider in the practice that issues prescription medication to patients. It requires a subscription to the ChiroPad eRx e-prescribing service. To turn on this function within ChiroPadEMR, go to Tools → Catalogs → User Security.

Once User Security is open, it will be necessary to open and edit each staff member that requires access to electronic prescribing.

Click on the User name and then on the Edit button. When the staff members account is open, click on the Permissions tab, scroll to the bottom of the list and place a check in eRx Access.
To go beyond this point, it requires a subscription to the ChiroPad eRx e-prescribing service. If your office is in this category, please call Life Systems Software sales at 800-543-3001 extension 1 for more details.
Index

I
initials 18

N
notes
  adding initials 18